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1. Introduction

The Quail Windows app is a geotechnical engineering software developed and maintained by
Geotechnical Services, Division of Engineering Services, California Department of
Transportation (Caltrans). This software is developed to facilitate and ensure consistent
collection of Caltrans geotechnical construction quality assurance test data in digital format and
assist in evaluating the test results.

Quail includes the following features:

e Allow consistent data entry.

e Provide options for all load schedules under Caltrans Standard Specifications.

o Display graphs of the test.

e Provide test summary with evaluations of pullout, elongation, and creep.

e Save data in a database format so that the data can be transmitted and upload into
Caltrans Quail database server.

o Save certified calibration data of multiple test equipment in the Quail calibration data
file. The file can be shared with your colleagues so that calibration data of the test
equipment used for a subsequent project can be retrieved and used.

The software runs under the Windows native operating system. The software will not function

on a computer running Windows through virtual machine software. You may download Quail
installation file from the link provided below.
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2. Getting Started

To get started with Quail, open the example calibration file and the example data file.

To open the example calibration file (.quailc), click on the Calibration Data Sheets B, icon in the first

screenshot below, and the Open = icon in the second screenshot below.

@ EBxample_20230814 - Quail

A Bl T=ln]=REs

File View Help

@ Calibration Data Sheets - Example_Calibrations 20230814

File View Calibrations Plot

DREL SN O

After you open the example calibration data file or a file with data properly entered and locked, Quail
will display the following Calibration Data Sheets panel, which includes two tabs:

e Equipment and Calibration Information, and
e Calibration Readings and Results.

@ Calibration Data Sheets - Example_Calibrations_20:

Eile View DataSheet Plot
@O Q Qs ARSI T
Identification | Calbration A o[
Calibration A
Equipment and Calibration Information  Calibration Readings and Resuts
500 —
Test Company |Sacramenbu TestLab | 450 —|
Name of Tester |camans PE California No. C00D00 |
Pump |EnerDE: Model ZU4408 LE-H 5/N 803507038 |
400 —|
Load cell | Omega LCMGD-10KN S/N A 10487 |
Gauge | McDaniel 0 - 10,000 psi S/N 32956 |
Ram |mmard Dudgeon 1x 150 Ton 5/N 600433 | 350 —
ektengt nches
300 —
£
= 250
@
2
S
[
£ 200 —|
&
150 —|
100 —
50 —]
This Data Sheet Is Locked
0
0 1000 2000 3000 4000 5000 6000 7000 8000 9000 10000
Gauge Pressure (psi)
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To open the example data file (.quail), click on the Open & icon in the following screenshot.

€ Example_20230214 - Quail

File View Help

_®

CEEmBOE M

After you open the example data file or a file with data properly entered, Quail will display the Quail
toolbar and a cascade of 5 viewing panels, ID, Settings, Measurements, Plot, and Test Summary. You
may navigate through the panels by clicking on each panel.

If you want the display to return to default cascaded-panels arrangement, select View - All Data

Panels or use the F6 key.

File View Help

B2 @

sl e e

View Project Wall Test

Project
[12 0000 0180 |
|oc 1405 widering |

<

wall
[53€ 3524 |
[rwsee |

PostMie: [07LA 405 RO4.30

Latitude * Longitude =

BegRW: +34.031562 -118.433584
EndRW: +34.031055 -118.433208

<

* Optional
Test
o) Subject Type Date. Pullout
A_001  Soil Nai Verification ~ 2020-06-19 <
A_002  Soi Nail Verification  2020-06-29
» Sol Nail Proof 2020-06-19
C_026  Soil Nai Proof 2020-06-13
D_002  Soi Nail Proof 2021-06-29
E010 Soi Nai Proof 2020-06-29
F_017  Soi Nai Proof 2020-06-29
G_084  Soi Nail Proof 2020-06-19

Yect

RW 549
B_075

:!.‘ est Summa

Test Equipment

E Equipment and Calorations Information  Calibration Readings and Results
[ T
pressre [ os|es Date
carce o |
JackLength inches
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3. Features

Calibration Data Sheets

At beginning of a construction project, you must enter certified calibration data of the test equipment to
be used for the project into the Quail Calibration Data Sheets or retrieve the calibration data from the
Quail calibration data file (.quailc).

Enter certified calibration data using the Calibration Data Sheets panel. You may save the data in the
calibration data file. The calibration data file with valid certified calibration data can be shared and used
for subsequent projects using the same test equipment.

PN

To enter or select a calibration data sheet click on the Calibration Data Sheets (&) icon in the first

. = . .
screenshot below, and the New — or Open icon in the second screenshot below.

@ Example_20230814 - Quail

File View Help

& &(e]PEBBE M

@ Calibration Data Sheets - Example_Calibrations_20230814

File View Calibrations Plot

BT L RN S

To enter a new set of calibration data, proceed with the following steps:

Step 1. Click on the Equipment and Calibration Information @ Calibration Data Sheets - Example_Calibrations 20230814
tab. File View DataSheet Plot
) N
Step 2. Enter data in the fields. . < Q q q /
p & -.
Identification |Ca|ibraﬁonA v|

Equipment and Calibration Information  Calibration Readings and Results

Date 12/5/2023

Test Company | Sacramento Test Lab

Name of Tester | Cal Trans PE California Mo, C00000

Pump | Enerpac Model ZU4408 LBE-H 5/N B035070338
Load Cel | Omega LCMGD-10KN S5/N A10487

Gauge | McDaniel 0 - 10,000 psi 5/N 32956

Ram | Richard Dudgeon 1 x 150 Ton 5/N 600433

Jack Length 11.000 | inches

Step 3. Click on the Calibration Readings and Results tab.
Step 4. Select the Measure option: Mesure -

Ram Force As a Function of Gauge Pressure
(Gauge Pressure As a Function of Ram Force

e Ram Force as a Function of Gauge Pressure, or
e Gauge Pressure as a Function of Ram Force
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Step 5.

Enter data in the fields.

Q Calibration Data Sheets - Example_Calibrations_20230814

File View DataSheet Plot

™ EBsQ Q6 AR NE

Identfication [Calbration A

||

Equipment and Calibration Information  Calibration Readings and Resuits

Measure ‘ Gauge Pressure As  Function of Ram Force

Ram
Force

Gauge Pressure. psi

kips Run 1 Run 2 Run 3 Average
‘ DEI[IH IEIDH IEIUH lDEIH L[]EI‘
‘ 25.00 ‘ ‘ 900 H 500 H 500 ‘ ‘ 500 ‘
‘ 50.00 ‘ ‘ 1750 H 1775 H 1750 ‘ ‘ 1758 ‘
‘ 75.00 ‘ ‘ 2600 H 2600 H 2600 ‘ ‘ 2600 ‘
‘ 100.00 ‘ ‘ 3400 H 3425 H 3400 ‘ ‘ 3408 ‘
‘ 125.00 ‘ ‘ 4250 H 4275 H 4250 ‘ ‘ 4258 ‘
‘ 150.00 ‘ ‘ 5075 H 5075 H 5050 ‘ ‘ 5!!57‘

175.00 5500 5500 ‘ 5900 ‘ 5900
‘ 200.00 ‘ ‘ 6750 H 6775 H 6750 ‘ ‘ 6758 ‘
‘ 250.00 ‘ ‘ 8300 H 8300 H 8300 ‘ ‘ 8300 ‘
‘ 270.00 ‘ ‘ 9050 H 9050 H 9050 ‘ ‘ 9050 ‘
| | | I |
R o - [r—— s

Gauge Pressure = | 33.071620 | psi/kips + -103.48 | psi

@ This Data Sheet Is Locked

Step 6.

Step 7.
Step 8.

Ram Force (kips)

500 —

450 —

400 —

350 —

300 —

250 —

200 —

150 —

100 —

50—

Calibration A

December 2023

0

1000 2000

3000

4000 5000

Gauge Pressure (psi)

6000 7000 8000 9000 10000

Check and ensure entered information and data are consistent with the certified calibration

sheet.

Generate Best Fit Line

Click on the Generate Best Fit Line button.
Click on the “Confirm and Lock” button to lock the data sheet. A data sheet that is not locked

will not be saved in the calibration file (.quailc).

This Data Sheet Is Not Locked

Confirm and Lock

Only data sheets that are locked will be saved in the calibration file (.quailc) and the calibration
formula can be use by Quail for test data conversion from ramp force to pump pressure gauge.

@ This Data Sheet Is Locked
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@ Calibration Data Sheets
Eile View DataSheet Plot

1 ELC RN S

Identiication | Calbration A

[

Equipment and Calibration Information - Calibration Readings and Resuts

Measure | Gauge Pressure As a Function of Ram Force

Ram Gauge Pressure psi

Force

kips Run 1 Run 2 Run3 | Average
‘ uunH mu” muH muH mu‘
‘ 25,00 H 200 || 200 H 300 H eau‘
‘ 50.00 ‘ ‘ 1750 || 1775 ‘ ‘ 1750 ‘ ‘ 1758 ‘
‘ 75.00 H 2600 || 2600 H 2600 H zsac‘
‘ muunH 3400” 3415H me ms‘
‘ 125,00 ‘ ‘ 4250 || 4275 ‘ ‘ 4250 ‘ ‘ 4258 ‘
‘ 150.00 ‘ ‘ 5075 || 5075 ‘ ‘ 5050 ‘ ‘ 5057‘

175.00 5900 5900 ‘

5300 ‘ 5900

[ wooo)[ e[ ems] [ e [ o)
[ 2000][ ewo][ smo|[ ssoo][ sw00]
[ woo][ ooso][ soso|[ sos][ auso)
\

Gauge Pressure =

[sorialossns :

@ This Data Sheet Is Locked

Ram Force (kips)

500 —

450 —

400 —

350 —

300 —

250 —

200 —{

150 —

100 —

50—

Calibration A

0

1000 2000 3000

4000 5000 6000 7000 8000 9000 10000

Gauge Pressure (psi)

Step 9. To apply an existing calibration data sheet from a
calibration data file, select the Calibration Data
Sheet from the calibration Identification
pulldown menu.
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Select Calibration Data Sheet for
001 EZAE T

Identification | Calibration A

Calibration A

Equipment and C2 Calibration-1

Calbration-3
Date
Test Company | Sacramento Test Lab

Name of Tester |Ca| Trans PE California No. C00000

Load Cell | Omega LCMGED-10KM 5/M A10487 |

Pump | Enerpac Model ZU4408 LB-H 5/M BO9507038
Gauge | McDaniel 0 - 10,000 psi 5/M 32956
Ram |R1d'ward Dudgeon 1 x 150 Ton S/M 600433

Jack Length 11.000 | inches
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Quail Test Data

@ Example_20230814 - Quail

Quail has three main menus: File, View, and Help.

> File @& e DEENE M
The File menu includes New, Open, Open Recent, Save, Save As, and Exit (Figure 2). File | View Help
| New Ctrl+N
:fl:'.' Open Ctrl+0
Open Recent 4
& Save Ctrl+5

Save As Ctrl+A

Exit
> View

The View includes options of viewing ID, Settings, Measurements, Plot, Test  view | Hep

Summary, All Test Panels, and selecting Calibrations Manager, and Button @ Calibration Data Sheets  Ctrl+C
Size. &) o A
Settings F2
You may open a panel by clicking on the selection in the View menu or 33 Measurements =
clicking one of the icons m/ERE [ in the Quail toolbar. Plot 2
[d Test summary Fs
All Test Panels Fb

Button Size 4
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> ID

The ID panel includes View, Project, Wall, and Test tabs. Ledl}

View Project Wall Test

View

The View tab includes Normal, Compact, Standard, All Records, and Expand Test

Grid OptionS View Project Wall Test
& MNormal
With Normal view, you can view all the three sections, Project, Wall, and Test, in a Compsct
single panel. e Standard
All Records
Expand Test Grid

View Project Wall Test

Project
12 0000 0180 B

0C I-405 Widening

wall

53E 3524 v
RW 549

Past Mile: |0?LA 405 RO44.30 |

Latitude * Longitude *

Beg RV: | +34.u31562|| -118.433584|

End R | +34.031055|| —118.433208|

* Optional
Test

D Reinforcement Type Date Pullout Creep Elongation Condusion A | ==

b 4001  Soil Nai Verification  2020-06-19 =

A_0D2  Soil Nai Verification  2020-06-20 [N | ok |

B_075  Sail Nai Proof 2020-06-13 IR L

c_026  sailNai Proof 2020-06-19

D002  Soil Nai Proof 2021-06-29 | mne | Reject |

E010  Soil Nai Proof 2020-06-29 K

F_017  Soil Mail Proof 2020-05-29 c

G_054  Soil Nai Proof 2020-06-19

To save screen real estate, you may select Compact view mode, which display only one section at a
time, either Project, Wall, or Test.

.

View Broject Wl Test
Project wal|{Test ]

Test

D | Renforcement

1200000280 v S 354 | N : ﬁWR
001 SoiNai Vet
A s .
oo [ or i vt
post e [o7L2 205 AG=30 £.075  SoiNel proof
oz soial Proof
lavde® ongude 0002 soiai froof
seonn [ rmwma 0w sotnet oot
Butans iy
EA wsomss| [ amasns U7 _Sckted froof
G964 soiai Froof
~Gptons

Select Standard to view test records of the project you are in. Select All Records to view wall test
records in the file.
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Create, Edit, Delete Records

There are three options to create, edit, and delete a project, wall, or test record.

Option 1.  On the ID toolbar, click  EXEEEEE
View Project Wall Test View Project Wall Test View Project Wall Test
on Praject’ Wall’ or Test S New Shift+Ins S New Ctrl+Ins Sp New Altlns
. S5 Edit  Shift-Enter Sp Bt CtsEnter (¥ New- CopySettings  ShiftAlteIns
to create neW, edlt, or )¢ Delcte  ShiftsDel Sj¢ Delete  CirleDel =5 ki Alt+Enter
Sy Delete Alt-Del

delete a project, wall, or
test record.
Option 2.  Click on the three-dots icon [ at the upper-right corner of each  » [-]

of the section to create new, edit, or delete the Project, Wall, TS New
and Test record. ¥, New- Copy Settings
Sy Edt
= Delete
Option 3. Right click on the selected record Test
D Reinforcement Type Date
A_001  Soil Nail Verification  2020-06
A_002  Soil Nail Verification  2020-06
YA ol G samaag
C_026 Soi —_+ Mew
D002 Soi | g, .
E 010  Soi| == Mew - Copy Settings
FOI7 Sol| =5 pdit
G_064 Soil| -
__1 Delete
To enter a new test record, select New tab and enter Test ID, Test
. . . . . Identification Number:
Subject (Soil Nail or Ground Anchor), Test Type (Verification, Proof for b vl e ]
soil nail, and Verification, Proof, Performance for ground anchor), and . ]
Load Schedule. == ‘
Verification v
Load Schedule:
Please note that Custom option of Load Schedule is currently not
available. Sor | Ko
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Most of the information
required in the Settings panel

View Project Wall Test

Project

December 2023

may be the same for a

| 12 0000 0130

| 0C I-405 Widening

structure. To avoid

wall

unnecessarily repeated data

|53E 3524

|RW 549

entries, you may use the New -

Post Mile: |u7m 405 R044.30

Copy Settings tab to copy

Latitude =

Longitude =

Beg RW: | +34.031562 | |

settings of a test already

-118.433584 ‘

Endri: [ 34031055 |

-118.433208 ‘

performed or entered and
create copies to the new tests.

*Optional

Test
D Subject Type Date | Pulout | Creep |Elongation  Condusion A
A_001  Sol Nail verificaton  2020-06-13 [JERS K K tl=
From the test ID Iist Select the A_002  Sol Nail Verificaton  2020-06-28 S New
’ b B075  Sol Nail Proaf 2020-06-1 [IEEE (] New- Copy Settings
C_026  Soi Nail proof 2020-06-19
teSt that you wa nt to co py the D_002  Soil Mail Proof 2021-06-29 _=’ Edit
H E_010  Soil Nail Proof 2020-06-29 —
Settlngs from. In the example F 017  Sol Nai Proof 2020-06-29 =y Delete
G064  Soi Nail Proof 2020-05-19

shown, test B_075 was -
selected. Then, right-click or
click the [ icon - New — Copy

Settings.
The New Test — Copy Settings panel will appear.

Enter the list of new test IDs that you want to have the
settings from B_075 to be copied to and click Add to
List. You may select and Remove the tests from the list.
You may also Clear the list.

When you finish entering the New Test IDs, click on the

Create Copies button. The new tests will be populated
in the Test list and the fields in the Settings panel will
also be populated.

Warning: Double check the values in the Settings fields

of each test that have been pre-populated using this
feature. Some tests may have some settings different
from the test you copied from. Be diligent. Correct the
settings values when needed.
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New Test - Copy Settings

Use the buttons below to prepare a list of New Test
ID's that will be duplicates of the Copy Test. Select
Create Copies to create the new tests.

Copy Test:

B_075

New Test ID's:

|c v| | D?5|to| ||

+ Add to List
x Remove from List
o Clear List
@ Create Copy(ies)

E Close
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» Setting

Enter information in the fields in the Setting panel. The panel is divided into General, Test Subject,

and Test Equipment sections.

Q Settings

View

General

Test Date

Tester's First Name
Tester's Last Name
Row

RW LOL Station
Elevation =
Latitude *
Longitude =

Drilled Hole Diameter
Criling Method
Water in Hole

Shotcrete Thidkness

* Optional

2020-06-19

H

IIIIIII

Jerimiah

Johnson

13+75.00 | =
5.00 | feet
+34.031162 | degs
-113.433255 | degs
~ | inches

Drag Bit/Air Flush w

0.000 | inches

= )
&
= a
< -

Test Subject

Bar Diameter

Bar Grade

Post Grout Pressure
Test Mail Length

Bonded Length Lb

1,128 inches - #9
75 | ksi
100 | psi
2,00 | feet

10.00 | feet

Pullout Resistance Qb 20 | kif

Test Load

12,00 | kips

Test Equipment

Equipment and Calibrations Information  Calibration Readings and Results

Identification
Date

Test Company
Name of Tester
Pump

Load Cell
Gauge

Ram

Jack Length

December 2023

| Calibration-4

2023-08-13

| Sacramento Testing Labs

[30hn 1. schmiat

| Pump 1

| Load Cell 1

| Gauge 1

|Ram1

[ oo

The General section records information such as the test date, tester, geospatial information, and
preparation of the test. This information can be used to reference to geotechnical condition of the

location provide by the geotechnical reports.

The Test Subject section records data of the test subject.

The Test Equipment section records test equipment used. The information is transferred from the

Calibration Data Sheet.
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» Measurements
Enter test readings in the Measurements panel.

The panel display the load schedule and measurement fields that require data entry according to
the load schedule selected in the ID panel.

If the test failed before the completion of a load test, enter the gauge pressure reading in the Failure
field.

Q Measurements

View

Load Schedule Using Test Load

Load Test Creep Tests
Hold Ram Gauge Movement Hold Movement at 0.80 T Movement at 1.00 T
Load Time Force Pressure From Start From First AL Time: From Start From First AL Delta From Start From First AL Delta

mins kips psi inches inches mins inches inches inches inches inches inches
AL Stable 4.35 28 0.000 0 0.104 0.101 0.000 0.162 0.159 0.000
0207 1-2 8.69 102 0.013 1 0.106 0.005 0,160 0.001
0.40T 12 17.39 250 0.051 2 0.108 0.005 0.165 0.006
060T 1-2 26.08 398 0.077 3 0.107 0.006 0.170 0.011
0.80T = 12 3478 546 0.101 4 0.107 0.008 0,175 0.016
Lo0m * 1-2 43.47 0894 0.159 5 0.107 0.006 0.180 0.021
AL Stable 4.35 2 0.110 6 0.107 0.005 0.185 0.026
Failure *= I:I 10 0.107 0.006 0.200 0.041

15 0.109 0.008

20 0.111 0.010

25 0.113 0.012

30 0.115 0.014

45 0.117 0.016

B0 0.120 0.018

* (Creep Test. The Load Test Movement must be recorded within the
spedfied Hold Time before the Creep Test is started.

*##* [f failure occurs record the measured Gauge Pressure.
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> Plot

The Plot panel display plots of load test and creep test. You may select display options of elongation,
creep, or both elongation and creep plots.

0 Piot — m}

View Plot

220 Q& AN

ELONGATION
Load T
0.00 020 040 0.60 0.80 1.00 1.20 1.40 1.60 1.80 2.00
0.00 | |

0.10—

0.20—

0.30—

Movement From First AL (inches)

0.40 —

0.50—

CREEP
o80T Time (minutes)

1007

0.000 —3 ‘
0.010—

0.020 —
0.030 —
0.040 —
0.050 —
0.060 —

Movement Delta (inches)

0.070 —
0.080 —
0.090 —

0.100—

Select Options from the pull-down menu or the Option ®
icon to adjust the display.

Plot Options

Time Maximurm Value

=}
=}

« | minutes
Movement Display Format 0.000
Movement Maximum Value j0. 100 - | inches

Movement Step 0.010 ~ | inches

Load Test
Load Display Format
Load Maximum Value T
s Ea—
Movement Display Format
Movement Maximum Value inches
Movement Step inches
Line Thickness pixels
Creep Test

Line Thickness -« | pixels

E Close
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» Test Summary

Test Summary panel displays the summary of the test, including pullout resistance, creep, and
elastic elongation.

The summary may show color coded , , or Warning. The evaluation of and [\[€ are based on
the criteria described in the Standard Specifications.

The display of Warning suggests the test and test data need detailed evaluation even though the
test may not be rejected according to the contract.

You may enter comments on the test in the Comments field.

Q Test Summary

View

Pullout Resistance

Measured failure load = not recorded “

Creep
Measured creep from 1 minute to 10 minutes = 0.080 inches.
Measured creep = (0.055 in - 0.000in) = 0.055 = 0.080in oK

Reinforcement Elastic Elongation

Total measured movement at the maximum test load minus the measured residual movement at the ending alignment load must be
between 80 percent and 140 percent of the theoretical elastic elongation of the sum of the unbonded length and the jacking
length.

Measured elastic elongation = (0.588in-0.531in) = 0.057in

(44,52 kips - 4.45 kips)[(12.00 ft - 10.60 f)(12 in/ft) +6.000in + 12,000 in]

Theoretical elastic elongation = = 0.157in
(29000 ksi)(1/4)(pi)(0.625 in)2
Measured elastic elongation 0.057
= = 36.4% < 80%
Theoretical elastic elongation 0.157
Comments

Conclusion: @
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